
Chapter 3

Two-Dimensional Finite Element

3.1 Introduction

The displacements, traction components and distributed body force values are func-

tions of the position indicated by (x, y)The displacement vector u is given as:

u = [u, v] T

where u and v are the x and y components of u. The stresses and strains are given

by

σ = [σx, σy, τxy]T ε = [εx, εy, γxy]T

Figure 1:

From Figure 3.1, representing the two-dimensional problem in general setting, the

body force, traction vector and elemental volume are given by:

f = [fx, fy]T , T = [Tx,Ty]T and dV = t dA
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where t is the thickness along the z direction. The strain-displacement relations are

given by

ε =
[
∂u

∂x
,
∂v

∂y
,

(
∂u

∂y
+
∂v

∂x

)]T

Stresses and strains are related by

σ = Dε

Figure 2:

Figure 3.2 above shows the two-dimensional region is divided into straight-sided tri-

angles. The points where the corners of the triangles meet are called nodes. Each

triangle is called an element. The elements �ll the entire region except a small region

at the boundary. It can be reduced by choosing smaller elements or elements with

curved boundaries. For two-dimensional problems, each node is permitted to displace

in only the two directions x and y. Thus, each node has two degree of freedom (dof).

The numbering scheme for the displacement are taken as Q2j−1in the x-direction and

in Q2j the y-direction. We denote the global displacement vector as

Q = [Q1, Q2, . . . , QN ] T

where N is the number of degrees of freedom. Information about the numbering

scheme can be seen from the element connectivity in Table 3.1 below.
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Table 1:
Element Number Three Nodes

e 1 2 3
1 1 2 4
2 4 2 7

...
...

...
...

11 6 7 10

...
...

...
...

20 13 16 15

The displacement components of a local node j in Figure 3.3 are represented as q2j-1

and q2j in the x and y directions. Thus, the element displacement vector is

q = [q1, q2, . . . , q6] T

Figure 3:
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Figure 4:

3.2.1 Displacement

The displacements at points inside an element as shown in Figure 3.4 above is repre-

sented as:

N1 +N2 +N3 = 1

where

N1 = ξ =
A1

A

N2 = η =
A2

A

N3 = 1− ξ − η =
A3

A

The displacements can be written using shape functions. We have:
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u = N1q1 +N2q3 +N3q5

v = N1q2 +N2q4 +N3q6

or becomes

u = [q1 + q5] ξ + (q3 + q5) η + q5

v = [q2 − q6] ξ + (q4 − q6) η + q6

In the x and y coordinates:

x = N1x1 +N2x2 +N3x3

y = N1y1 +N2y2 +N3y3

or

x = (x1 − x3) ξ + (x2 − x3) η + x3

y = (y1 − y3) ξ + (y2 − y3) η + y3

or in simpler way

x = x13ξ + x23η + x3

y = y13ξ + y23η + y3

3.2.2 Strain

Using chain rule, partial derivatives of u and v with respect to x and y or ξ and η

gives.

∂u

∂ξ
=
∂u

∂x

∂x

∂ξ
+
∂u

∂y

∂y

∂ξ
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∂u

∂η
=
∂u

∂x

∂x

∂η
+
∂u

∂y

∂y

∂η

which can be written in matrix notation as{
∂u
∂ξ
∂u
∂η

}
=

[
∂x
∂ξ

∂y
∂ξ

∂x
∂η

∂y
∂η

]

where (2x2) matrix is denoted as the Jacobian of the transformation, J:

J =

[
∂x
∂ξ

∂y
∂ξ

∂x
∂η

∂y
∂η

]

On taking the derivatives of x and y,

J =

[
x13 y13

x23 y23

]

Strain, ε

ε =


∂u
∂x
∂v
∂y
∂u
∂y + ∂v

∂x



ε =
1

det J


y21q1 + y31q3 + y12q5

x32q2 + x13q4 + x21q6

x32q1 + y23q2 + x13q3 + y31q4 + x21q5 + y12q6


This equation can be written in matrix form as ε = Bq, where

B =
1

det J

 y23 0 y31 0 y12 0
0 x32 0 x13 0 x12

x32 y23 x13 y31 x21 y12



3.2.3 Potential-Energy Approach, Π

The potential energy of the system, Πis given as:
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Π =
1
2

ˆ
A

εTDεt dA−
ˆ
A

uTft dA−
ˆ
`

uTt d`−
∑
i

ui
TPi

3.2.4 Galerkin Approach

Variational form is given by:

ˆ
A

σTε(φ) t dA−

(ˆ
A

φTft dA +
ˆ
`

φTTt d`−
∑
i

φi
TPi

)
= 0

3.2.5 Element Sti�ness

Element strain energy is given by :

Ue = 1
2

´
e
εTDεt dA

= 1
2

´
e

qTBTDBqt dA
= 1

2qTBTDBqte
´
e
dA

= 1
2qTteAeBTDBq

= 1
2qTkeq

where ke is the element sti�ness matrix is given by:

ke = teAeBTDB

then

U =
∑
e

1
2

qTkeq

U =
∑
e

1
2

qTKQ

3.2.6 Force Terms

1) Body force term
´
e

uTft dA is given by :

ˆ
A

uTft dA =qTfe
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where fe is the element body force vector given by:

fe =
teAe

3
[fx, fy, fx, fy, fx, fy]T

Global force vector F is:

F =
∑

e

fe

2) Traction force term,
´
`
uTTt d`is given by:

ˆ
`1−2

uTTt d` = [q1 , q2 , q3 , q4 ] Te

where Te is:

Te =
te`1−2

6
[2Tx1 + Tx2, 2Ty1 + Ty2, Tx1 + 2Tx2, Ty1 + 2Ty2, ] T

where,

`1−2 =
√

(x2 − x1)2 + (y2 − y1)2

3) Point load term, uTPiis given by:

uTPi = Q2i−1Px +Q2iPy

The contribution of body forces, traction forces and point loads to the global force F

can be represented as:

F←
∑
e

(fe + Te) + P

The total potential energy, Πis given by:

Π =
1
2

QTKQ−QTF

Then,
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KQ =F

where K and F are modi�ed sti�ness matrix and force vector.

3.2.7 Stress Calculation

Using the stress-strain relations and element strain-displacement relations, stress, is

given by:

σ = DBq

3.2.8 Temperature E�ects

The element temperature load is given by:

θe = teAeBTDε0

For plane stress, ε0 = [α∆T, α∆T, 0] T

For plane strain, ε0 = (1 + v) [α∆T, α∆T, 0] T

Example: For the two-dimensional loaded plate shown in Figure 3.5 below, deter-

mine the displacement of nodes 1 and 2 and the element stresses using plane stress

conditions. Body force may be neglected in comparison with the external forces.
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Figure 5:

Solution:

For plane stress conditions, the material property matrix is given by:

D =
E

1− v2

 1 v 0
v 1 0
0 0 1−v

2

 =

 3.2x107 0.8x107 0
0.8x107 3.2x107 0

0 0 1.2x107


Using the local numbering pattern, we establish the connectivity as follows:

Element Number Three Nodes

1 2 3

1 1 2 4

2 3 4 2

We know that:

Be =
1

det J

 y23 0 y31 0 y12 0
0 x32 0 x13 0 x12

x32 y23 x13 y31 x21 y12


where, det J = x13y23 − x23y13
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On performing the matrix multiplication DBe, we get

DB1 = 107

 1.067 −0.4 0 0.4 −1.067 0
0.267 −1.6 0 1.6 −0.267 0
−0.6 0.4 0.6 0 0 −0.4



DB2 = 107

 −1.067 0.4 0 −0.4 −1.067 0
−0.267 1.6 0 −1.6 −0.267 0

0.6 −0.4 −0.6 0 0 −0.4


These two relationship will be used later in calculating stresses using σe = DBeq

The multiplication teAeBeTDBe gives the element sti�ness matrices,

k1 = 107



0.983 −0.5 −0.45 0.2 −0.533 0.3
1.4 0.3 −1.2 0.2 −0.2

0.45 0 0 −0.3
1.2 −0.2 0

0.533 0
Symetric 0.2



k2 = 107



0.983 −0.5 −0.45 0.2 −0.533 0.3
1.4 0.3 −1.2 0.2 −0.2

0.45 0 0 −0.3
1.2 −0.2 0

0.533 0
Symetric 0.2


In the problem under consideration, Q2, Q5, Q6, Q7 and Q8 are all zero.

Using the elimination approach, it is su�cient to consider the sti�ness associated

with the degree of freedomQ1, Q3 and Q4. Since the body force is neglected, the �rst

vector has the component F4 = -1000lb. The set of equation is given by the matrix

representation:

107

 0.983 −0.45 0.2
−0.45 0.983 0

0.2 0 1.4




Q1

Q2

Q3

 =


0
0

−1000


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Solving for Q1, Q3 and Q4we get,

Q1 = 1.913x10−5in, Q3 = 0.875x10−5in, Q4 = −7.436x10−5in

For element 1, the element nodal displacement vector is given by:

q1 = 10−5
[

1.913 0 0.875 −7.436 0 0
]

T

The element stresses, σ1are calculated from DB1q

σ1 =
[
−93.3 −1138.7 −62.3

]
T psi

Similarly,

q2 = 10−5
[

0 0 0 0 0.875 −7.436
]

T

σ2 =
[

93.4 23.4 −297.4
]

T psi

Solution using CST program

Input data �le for CST program

2D STRESS ANALYSIS USING CST
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The computer result may di�er slightly since the penalty approach for handling

boundary conditions is used in the computer program.

3.3 Basic Modeling and Simulation Procedures Using Femlab

Model Navigator

The Model Navigator appears when we start Femlab or when you restrart from stracth

within femlab by selecting New from the File menu or clicking on the New toolbar

button. In the Model Navigator, we specify the application mode, names of depen-

dent variables and the nature of the problem; stationary(static), eigenfrequency, time

dependent(transient), quasi static, parametric or frequency response.

Options and Settings

This section reviews basic settings for example those for the axes and grid spacing.

All settings are accessible from the Options menu. It is possible to de�ne material,

loads and constraints in a user de�ned coordinate system.

Geometry Modeling

� Either the model geometry is set up inside Femlab or imported from other

software in 1D, 2D or 3D.

� DXF fail format for 2D geometry.

� IGES fail format for 3D geometry.

13



Physic Settings

Material properties are usually de�ned on the subdomain.

Application Mode Properties

Application mode properties are global properties controlling the analysis starting

with which analysis to perform. Make all corresponding settings in the Application

Mode Properties dialog box, which you open from Properties in the Physics menu.

Application Scalar Variables

Application scalar variables are global variables de�ning an analysis. The Structural

Mechanics Module application modes have only one variable, freq, the excitation

frequency in a frequency-response analysis. To open the Application Scalar Variables

dialog box go to the selection Scalar Variables in the Physics menu.

Point Settings

We de�ne loads and constraints on points in Point mode. Point settings are used in

all Structural Mechanics Module application modes, whereas point masses are de�ned

in the Beam application modes.

Edge Settings

Edge settings are used only in these 3D application modes: shell, solid, and beam.

In the Beam application mode we de�ne physical properties as well as loads and

constraints, whereas the other application modes de�ne only loads and constraints.

Boundary Settings

In Boundary Selection mode, we specify loads and constraints on the edges (in 2D)

or faces (in 3D). For In-plane Euler beams and shells the physical properties are also

de�ned.

Subdomain Settings

In Subdomain Selection mode, we specify the properties of the material. We can also

control the element to use from this dialog box. For all continuum application modes
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we can select the order of the Lagrange element. In addition, for time-dependent and

nonlinear problems we set initial conditions for subdomains in this mode.

Mesh Generation

At this stage the software meshes the geometry. We simply click on one of the Mesh

buttons in the Main toolbar; in other cases it is necessary to set some mesh parameters

using the Mesh menu and the Mesh Parameters dialog box.

Computing the Solution

To compute the solution, press the Solve Problem toolbar button on the Main toolbar.

We can speci�c settings for each solver in the Solver Parameters dialog box.

Postprocessing and Visualization

FEMLAB's powerful visualization tools are accessible in the program's Postprocessing

mode, but to use them we must be familiar with the Postprocessing menu.

Steps to model and simulate using Femlab are stated below:

1. Geometry modeling :

� Either the model geometry is set up inside Femlab or imported from other

software in 1D, 2D or 3D.

� DXF �le format for 2D geometry.

� IGES �le format for 3D geometry.

2. De�ning material data or material properties.

3. De�ning constraint dan applied loads.

4. Mesh generation.

5. De�ning type of analysis.

6. Computing the solution.

7. Postprocessing and visualization.
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Static Analysis

Below is a geometry and structure with height of 12 cm and 5 cm width. The top

portion of the structure is constraint and 4000N load is applied at the bottom section.

Model Geometry:

Figure 6:

Material and element data:

1. Material is structural steel.

2. Top portion is constrained and load of 4000 N is applied at the bottom section.

3. Geometry thickness is 1 cm.

Note : All unit in Femlab is SI unit.
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PROCEDURES :

1) Model Navigator

1. Double click on the Femlab icon on the desktop.

2. Go to the New page in the Model Navigator, then select 2D from the Space

dimension list.

3. On that same page, select Structural Mechanics Module, Plane Stress, Static

analysis.

4. Click on OK to close the Model Navigator.

2) Geometry Modeling

De�ning axes and grid size:

� From Options menu, choose Axis/Grid Settings. Click on the Grid tab and

click once more on the Auto box to de�ne axes or grid size manually. Set 0.05

for x, y and z-spacing. Click on Apply and click OK to close the dialog box.
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Create Points:

� Using the Point button at the side toolbar, create two points at (0,0) and

(0.05,0).

� Click on the Zoom In button at the top toolbar to enlarge image.

� Create a point at (0.05,0.12). To do this, �rst, make a point at (0.05,0.1). Click

twice on that point. Object Properties dialog bix will appear. Choose 1 in

the Point selection and write 0.05 for x and 0.12 for y in Point properties.

� Click Apply and OK.

� Similarly, make four more points at (0,0.12), (0,0.08), (0,0.06), (0,0.04).

� All created points are shown below.
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Enlarge Image:

� To enlarge image, click the Zoom In , Zoom Window or Zoom Extents

button placed at the top toolbar.

Create lines connecting the points:

� Click on the Line button at the side toolbar to make lines.

� To make a line connecting points 1 and 2, left click on point 1 and left click

once again on point 2. Then right click.
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Make circle :

� Make a circle at coordinate (0,0.06) with diameter of 0.04 m by clicking on the

Ellpise/Circle (Centered) button placed at the side toolbar.

� To make it easier, grid size will be reduced to 0.01. Click on the Options menu

and choose Axis/Grid Settings. Set 0.01 in the x, y and z spacing.

� Click on the Ellpise/Circle (Centered) button. Click at coordinate of (0,0.06)

and make a circle.

� Click twice on the circle. In the Ellipse dialog box, make sure that A-semiaxes

and B-semiaxes is 0.02. In the Position space, Base is center, x:0 and y:0.06.

� Click Apply and OK.
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Create solid object:

� Choose/click all entities (lines, points, circle) and click Coerce to Solid button

placed at the side toolbar. Use the shift button on the keyboard to select more

than one entities.
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� The circle will be separated from the geometry to produce our �nal geometry.

Click on the Split object button. Then click on the Di�erence button. All

this button placed at the side toolbar.

3) De�ning material data or material properties.

After setting up the geometry, second step is to de�ne material data or material

properties. For this problem, the material data is taken from the Femlab Material

library.

Click on the Physics menu and choose Subdomain Settings.

� In Subdomain Settings dialog box, click at the Material tab.

� In the Subdomain selection , choose 1 and click on the Load button to choose

material.

� Choose Structural steel and click Apply. Then click OK to close the dialog box.

� In the Subdomain Settings dialog box, set the element thickness as 1 cm by

writing 0.01 in the Thickness edit �eld.
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� Click Apply and OK to close the dialog box.

4) De�ning constraint and applied loads

In this third step, constraint ang applied loads will be de�ned.

De�ning constraint:

� In Phsyics menu, choose Boundary Settings.

� Click on the line on top of the geometry and set Constraint in the x and y

direction by clicking on the Rx and Ry box.

� Click Apply.
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De�ning applied loads:

� Click on the bottom line of the geometry.

� Click on the Load tab.

� Make sure that the Edge load is de�ned as force/length is on.

� In the Fy edit �eld, write -80000 N/m . Negative sign shows that the load is

downward. (Note: 4000/0.05 = 80000 N/m).
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� Click on the Apply button and OK button to close the dialog box

5) Mesh generation

After constraint and applied loads are de�ned, mesh will be generated.

� Mesh is generated automatically by clicking the Initialize Mesh button. Mesh

size can be reduced to obtained better result by clicking the Re�ne Mesh

button.

� Now, click on the Initialize Mesh button placed on the top toolbar.

� Mesh parameter such as size, element growth rate and curvature factor can be

change by choosing Mesh Parameters from the Mesh menu list.
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6) De�ning type of analysis.

After mesh is generated, type of anlaysis need to be de�ned. Analisis bagi struk-

tur ini adalah analisis statik dan ubahbentuk struktur adalah dalam kawasan linear

memandangkan daya yang diaplikasikan adalah lebih rendah berbanding takat alah

bahan.

� Click on the Physics menu and choose Properties.

� In the Application Mode Properties dialog box, choose Static linear as

the Analysis type.
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� Large deformation and Weak constraint are set o�.

� Click on the OK button to close the dialog box.

7) Computing the solution

� Click on the Solve menu and choose Solver Parameters.

� Make sure the Analysis is Static linear and Solver is Stationary linear.

� Click Apply button and then OK button.

� Simulation is performed by clicking the Solve button placed on the top toolbar.
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8) Postprocessing and visualization

In this postprocessing and visualization, analysis result such as von mises stress, x

displacement and y displacement will be visualized.

i) Von Mises Stress.

� The result of von mises stress on the surface structure is shown below.
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ii) Structure deformation:

� Click on the Postprocessing menu and choose Plot Parameters.

� Click on the General tab. Click on the Deformed shape box. Then click

Apply and OK.

� The result of structure deformation under applied load is shown below.

iii) Point of maximum and minimum von mises stress

� Click on the Postprocessing menu and choose Plot Parameters. Click on

the Max/Min tab. In the Plot Parameter dialog box, make sure that Pre-

de�ned quantities is Von Mises Stress.

� Click on the Max/min marker box to activate the marker. Click Apply and

then OK.

� Points where the von mises stress is maximum or minimum is plotted on the

geometry with the value.
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iv) x -displacement :

� Click on the Postprocessing menu and choose Plot Parameter.

� Click on the Surface tab and in the Prede�ned quantities edit �eld choose

x -displacement. Make sure that the Surface plot box is marked.

� Click on the Apply button.

� Click on theMax/Min tab and in the Prede�ned quantities edit �eld choose

x -displacement. Make sure that the Max/min marker box is marked.

� Click on the Apply button and then OK button to close the dialog box.

� The result is shown below.

� The point where x -displacement is maximum is plotted on the geometry with

its value.

� The y-displacement can be obtained by changing the Prede�ned quantities

edit �eld to y-displacement.
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v) Cross section plot of Von Mises Stress:

To see the von mises stress on a cross section, Untuk melihat von mises stress pada

keratan struktur, paparan keputusan perlu di ubah kepada paparan von mises stress

kembali.

� Click on the Postprocessing menu and choose Plot Parameters.

� Click on the Surface tab.

� Choose von mises stress as Prede�ned quantities and click Apply.

� Then click on the Max/Min tab and click on the Max/min marker box to

activate.

� Click on the Apply button and after that OK button.

� After that, in the Postprocessing menu, choose Cross Section Plot Pa-

rameters.

� Click on the General tab. In the Plot type edit �eld, make sure that the

Line/Extrusion plot circle is marked.

� Click on the Line/Extrusion tab.

� Prede�ned quantities is von mises stress and x-axis data is x.
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� In the Cross-section line data edit �eld, set x0=0.02, y0=0.06, x1=0.05,

y1=0.06.

� Click on the Apply button and then OK button.

� The result is shown below.

The result is obtained using normal mesh size. Now, we will reduce the mesh size to

compare the result.

� Click on the Mesh menu and choose Mesh Parameters.

� In the Prede�ned mesh sizes, choose Extra �ne and click on the Remesh

button.
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� Click on the OK button

� Run the analysis by clicking on the Solve button placed at the top toolbar.

� Note that the analysis will take longer time compared by using normal mesh

size.
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� Now, click on the Postprocessing menu and choose Plot Parameters.

� Click on theMax/Min tab and the Prede�ned quantities is von mises stress.

Then, click on the Max/min marker box to activate.

� Click on the Apply button and then OK button.

� The result is shown below.

� It can be noticed that the von mises stress value is di�erent compared by using

normal mesh size.

� Now, using Extra �ne mesh size, repeat steps above for x and y displacement

to compare the result.
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